1-Mavzu: Ikki va uch o‘lchamli kompyuter grafikasi turlari.
1-topshiriq. Nazariy qiyoslov (Venn diagrammasi)
Ikki o‘lchamli (2D) va uch o‘lchamli (3D) grafikani o'zaro solishtiring:
· 2D grafika: Ta'rifi, asosiy o'lchamlari ($x, y$), ishlatiladigan sohalar.
· 3D grafika: Ta'rifi, qo'shimcha o'lchami ($z$), realistiklik darajasi.
· Umumiy jihatlari: Ikkala tur uchun ham xos bo'lgan xususiyatlarni aniqlang.
2-topshiriq. Tasniflash jadvali
Quyidagi jadvalni kompyuter grafikasi turlariga qarab to'ldiring:
	Grafik turi
	Asosiy elementi
	Afzalligi
	Kamchiligi
	Dasturlarga misol

	Rastrli (2D)
	Piksel
	Fotosuratlar uchun mos
	Kattalashtirganda sifat yo'qoladi
	Photoshop

	Vektorli (2D)
	?
	?
	?
	CorelDraw

	Fraktal (2D)
	?
	?
	?
	?

	3D grafika
	Poligon / To'r
	?
	?
	3ds Max, Blender


3-topshiriq. Amaliy tahlil (Case Study)
Quyidagi vaziyatlar uchun grafikaning qaysi turidan foydalanish eng to'g'ri qaror ekanligini asoslab bering:
1. Katta o'lchamdagi reklama banneri uchun kompaniya logotipini chizish.
2. Zamonaviy kompyuter o'yini uchun personaj yaratish.
3. Professional badiiy fotosuratni tahrirlash va ranglarini to'g'rilash.
4. Arxitektura binosining ichki dizaynini (interyer) loyihalash.
4-topshiriq. Ijodiy izlanish (Referat yoki Taqdimot)
Quyidagi mavzulardan birini tanlab, qisqacha ma'lumot tayyorlang:
· "3D grafikada renderlash (vizuallashtirish) jarayoni: u qanday ishlaydi?"
· "Kompyuter o'yinlari sanoatida 2D va 3D grafikaning roli."
· "CGI (Computer-Generated Imagery) texnologiyasi zamonaviy kinemotografiyada."
5-topshiriq. Mantiqiy savollar
1. Nima uchun 3D modelni ekranda ko'rganimizda u baribir 2D tasvir sifatida namoyon bo'ladi?
2. "Poli" (polygon) soni 3D modelning sifatiga qanday ta'sir qiladi?
3. Vektorli grafika nima uchun muhandislik chizmalarida (AutoCAD va h.k.) rastrli grafikadan ustun hisoblanadi?






















2-Mavzu: Vektorli va fraktal grafika asoslari
1. Nazariy qism: Tushunchalar tahlili
Quyidagi savollarga javob bering:
· Vektorli grafikada tasvir qanday elementlar (geometrik primitivlar) yordamida shakllantiriladi?
· Vektorli tasvirlarni cheksiz kattalashtirganda sifatining o'zgarmasligi sababini tushuntiring.
· Fraktal grafika nima? Uning yaratilishida matematik formulalarning o'rni qanday?
· "O'z-o'ziga o'xshashlik" tamoyili fraktal grafikada qanday namoyon bo'ladi?
2. Amaliy jadval: Qiyosiy tavsif
Vektorli va fraktal grafikani o'zaro solishtirib, jadvalni to'ldiring:
	Xususiyati
	Vektorli grafika
	Fraktal grafika

	Asosiy elementi
	Chiziqlar, nuqtalar, egri chiziqlar
	Matematik formula (tenglama)

	Asosiy afzalligi
	?
	?

	Asosiy kamchiligi
	?
	?

	Qo'llanilish sohasi
	?
	?

	Dasturiy ta'minot
	?
	?


3. Mantiqiy topshiriq: "Qaysi biri mos?"
Quyidagi vazifalar uchun grafikaning qaysi turi (Vektorli yoki Fraktal) tanlanishini aniqlang va sababini keltiring:
1. Kompaniya uchun har qanday o'lchamda chop etilishi mumkin bo'lgan logotip yaratish.
2. Tabiat manzaralarini (bulutlar, tog'lar, dengiz to'lqinlari) realistik va kompyuter xotirasini tejagan holda modellashtirish.
3. Muhandislik chizmalari va arxitektura rejalarini tayyorlash.
4. Abstrakt san'at asarlari va murakkab geometrik naqshlar yaratish.
4. Ijodiy izlanish
Quyidagi mashhur fraktal tuzilmalardan biri haqida qisqacha ma'lumot to'plang va uning ko'rinishini tasvirlang:
· Mandelbrot to'plami
· Kox qor parchasi
· Sierpinskiy uchburchagi
5. Baholash testi
· Vektorli grafika formati qaysi javobda to'g'ri ko'rsatilgan?
· A) .jpg, .png
· B) .svg, .ai, .cdr
· C) .mp3, .mp4
· Fraktal grafika asosan qaysi sohada keng qo'llaniladi?
· A) Matnlarni tahrirlashda
· B) Tabiiy ob'ektlarni simulyatsiya qilishda
· C) Fotosuratlarni tahrirlashda



















3-Mavzu: Adobe Photoshop dasturi interfeysi va asosiy uskunalari.
1. Nazariy qism: Interfeys elementlarini tahlil qilish
· Menu Bar (Menyular satri): Fayllar bilan ishlash va umumiy buyruqlar uchun.
· Options Bar (Xususiyatlar paneli): Tanlangan uskunaning parametrlarini sozlash uchun.
· Tools Panel (Uskunalar paneli): Tasvirga ishlov berish uchun asosiy qurollar to'plami.
· Layers Panel (Qatlamlar paneli): Tasvir qatlamlari bilan ishlash va ularni boshqarish uchun.
2. Amaliy topshiriq: "Uskunalar xazinasi"
Quyidagi uskunalarning klaviatura orqali chaqiriladigan "qaynoq tugmalari" (hotkeys) va vazifasini jadval ko'rinishida to'ldiring:
	Uskuna nomi
	Qaynoq tugmasi
	Asosiy vazifasi

	Move Tool
	V
	Obyektlarni ko'chirish

	Marquee Tool
	M
	?

	Lasso Tool
	L
	?

	Crop Tool
	C
	?

	Brush Tool
	B
	?

	Eraser Tool
	E
	?


3.Yangi hujjat yaratish va sozlash
Amaliy ravishda quyidagi parametrlarga ega yangi fayl yarating va jarayonni izohlang:
1. Hujjat nomi: "Mustaqil_ish_1".
2. O'lchami: Eni 1920 px, bo'yi 1080 px.
3. Ruxsat etish darajasi (Resolution): 72 ppi.
4. Rang modeli (Color Mode): RGB.
5. Fon: Shaffof (Transparent).
4. Mantiqiy savollar (Tahlil)
· Nima uchun Photoshop dasturida qatlamlar (Layers) bilan ishlash juda muhim hisoblanadi?
· Tasvirni kattalashtirish (Zoom) uchun interfeysdagi qaysi uskuna yoki tugmalar birikmasidan foydalaniladi?
· Interfeysdagi panellar (masalan, Layers yoki History) yo'qolib qolsa, ularni qaysi menyu orqali qaytarish mumkin?
5. Ijodiy vazifa
Photoshop interfeysini o'zingizga qulay qilib sozlang (masalan, kerakli panellarni joylashtiring) va ushbu muhitni Workspace (Ishchi soha) sifatida saqlang. Saqlash jarayonini ketma-ketlikda yozib bering.
Baholash mezonlari:
· Interfeys elementlarining to'g'ri tavsiflanishi.
· Uskunalarning vazifalarini aniq bilish.
· Yangi hujjat yaratish parametrlarini to'g'ri qo'llash.


















4-Mavzu: PhotoShopda grafik fayl formatlari va ular bilan ishlash.
1. Nazariy qism: Fayl formatlari tahlili
Quyidagi savollarga javob bering va jadvalni to'ldiring:
· PSD formati nima va u boshqa formatlardan (masalan, JPG) qanday farq qiladi?
· Shaffof (transparent) fonli tasvirlarni saqlash uchun qaysi formatdan foydalanish eng to'g'ri?
· Tasvirning sifatini yo'qotmasdan saqlash (Lossless) deganda nimani tushunasiz?
	Format
	To'liq nomi
	Asosiy xususiyati
	Qo'llanilish sohasi

	PSD
	Photoshop Document
	Qatlamlarni (layers) saqlaydi
	Ishchi loyihalar uchun

	JPEG
	Joint Photographic Experts Group
	?
	?

	PNG
	Portable Network Graphics
	?
	?

	TIFF
	Tagged Image File Format
	?
	?

	GIF
	Graphics Interchange Format
	?
	?



2. Amaliy topshiriq: "Eksport qilish mahorati"
Adobe Photoshop dasturida quyidagi amallarni bajaring:
1. Yangi loyiha yarating: PSD formatida saqlang.
2. Tasvirni tahrirlang: Bir nechta qatlamlar (matn, shakl, rasm) qo'shing.
3. Turli formatlarda saqlash:
· Loyiha nusxasini internetda chop etish uchun JPG formatida (sifatini 80% qilib) saqlang.
· Loyiha tarkibidagi bitta obyektni (fonsiz) PNG-24 formatida eksport qiling.
4. Hajm tahlili: Bir xil tasvirning JPG va PSD formatdagi fayl hajmlarini solishtiring va farqini izohlang.
3. Texnik tahlil: "Save As" va "Export As"
Dasturdagi quyidagi buyruqlar o'rtasidagi farqni tushuntirib bering:
· File -> Save As...
· File -> Export -> Export As... (yoki Quick Export as PNG)
· File -> Save for Web (Legacy)... — Bu buyruq nima uchun hali ham ishlatiladi?
4. Muammoli vaziyat (Logical Task)
Siz professional matbaaga (bosmaxonaga) banner tayyorladingiz. Bosmaxona xodimi sizdan loyihani "qatlamlari birlashtirilgan, lekin sifat yo'qolmagan holda" yuborishingizni so'radi.
· Savol: Siz qaysi formatni tanlaysiz va nima uchun?
5. Ijodiy vazifa
Ijtimoiy tarmoqlar (Instagram yoki Telegram) uchun rasm tayyorlashda eng maqbul fayl parametrlarini (o'lcham, format, rang modeli) aniqlang va ushbu ko'rsatmalarni kichik qo'llanma ko'rinishida yozing.
Topshiriqni topshirish shakli:
· Nazariy savollarga yozma javoblar.
· Bajarilgan loyihaning turli formatdagi (.psd, .jpg, .png) fayllari jamlangan papka.
















5-Mavzu: Photoshopda tasvir bo‘laklarini jratib olish usullari.
1. Nazariy qism: Seleksiya (ajratish) asboblari tahlili
Quyidagi usullarning bir-biridan farqi va qaysi holatlarda ishlatilishini tushuntirib bering:
· Magic Wand (Sehrli tayoqcha): Ranglar uyg‘unligi bo‘yicha ajratish.
· Quick Selection (Tezkor ajratish): Ob'ekt chegaralarini aqlli aniqlash.
· Object Selection Tool: Sun'iy intellekt yordamida ob'ektni bir marta bosish orqali ajratish.
· Magnetic Lasso (Magnitli lasso): Konturlar bo‘ylab "yopishib" ajratish.
2. Amaliy topshiriq: "Murakkab ob'ektlar bilan ishlash"
Adobe Photoshop dasturini oching va quyidagi mashqlarni bajaring:
A. Rang bo‘yicha ajratish (Color Range):
1. Bitta rangli fonga ega bo‘lgan (masalan, ko‘k osmon yoki yashil o‘t) rasmni yuklang.
2. Select -> Color Range menyusi orqali faqat ma'lum bir rangdagi joylarni ajratib oling va ularni boshqa rangga bo‘yang.
B. Soch yoki hayvon yungini ajratish (Select and Mask):
1. Inson portreti yoki junli hayvon rasmini yuklang.
2. Ob'ektni umumiy ajratib oling, so‘ngra Select and Mask (Ajratish va niqoblash) oynasiga oting.
3. Refine Edge Brush (Qirralarni aniqlashtirish mo‘yqalami) yordamida soch tolalari yoki yunglarni fondan aniq ajratib olishga harakat qiling.
3. Qiyosiy jadval: Qaysi asbob afzal?
Vaziyatdan kelib chiqib, eng samarali asbobni belgilang:
	Vaziyat
	Tavsiya etilgan asbob
	Sababi

	Bir xil rangdagi studiya foni
	?
	?

	Geometrik aniq shakllar (kvadrat, doira)
	?
	?

	Murakkab daraxt shoxlari yoki sochlar
	?
	?

	Konturi aniq bo‘lmagan xira tasvirlar
	?
	?


4. Mantiqiy topshiriq: "Niqoblar bilan ishlash" (Layer Mask)
Tasvir bo‘lagini butunlay o‘chirib tashlamasdan (non-destructive), uni yashirish uchun Layer Mask (Qatlam niqobi) dan foydalanishning afzalliklari nimada? Oq va qora ranglar niqobda qanday vazifani bajarishini tushuntiring.
5. Ijodiy vazifa: "Fotokollaj yaratish"
Kamida 3 xil usuldan (Lasso, Magic Wand, Pen Tool yoki Select Subject) foydalangan holda, turli rasmlardan olingan bo‘laklarni bitta fonga yig‘ib, mantiqiy kollaj yarating. Har bir bo‘lakni ajratishda qaysi usuldan foydalanganingizni izohlang.
Topshiriqni topshirish shakli:
1. Nazariy savollarga yozma javoblar (daftarda yoki Word formatida).
2. Bajarilgan amaliy ishning .psd (qatlamlari bilan) va .jpg (yakuniy natija) fayllari.



















6-Mavzu: Photoshopda kadrrash (Crop) va transformatsiya (Transform) amallari
1. Nazariy qism: Atamalar tahlili
Quyidagi savollarga qisqacha javob bering:
· Kadrlash (Crop) amali tasvirning qaysi qismlariga ta'sir qiladi va u nima uchun ishlatiladi?
· Free Transform (Erkin transformatsiya) buyrug'ini chaqiruvchi klaviatura tugmalari birikmasini ko'rsating.
· Tasvirni shaklini o'zgartirganda (masalan, kattalashtirganda) uning nisbatlari (proportsiyasi) buzilmasligi uchun qaysi tugma bosib turiladi?
2. Amaliy topshiriq: "Tasvir kompozitsiyasini to'g'rilash"
Adobe Photoshop dasturini oching va biron bir manzara yoki portret rasmini yuklang. Quyidagi bosqichlarni bajaring:
1. Kadrlash (Crop Tool - C):
· Rasmdagi ortiqcha bo'shliqlarni olib tashlang.
· Rule of Thirds (Uchdan bir qoidasi) tarmog'idan foydalanib, asosiy ob'ektni markazga yoki kesishish nuqtalariga joylashtiring.
· Straighten (Tekislash) funksiyasi yordamida qiyshiq ufq chizig'ini to'g'rilang.
2. Transformatsiya (Edit -> Transform):
· Rasmdagi biror elementni tanlab oling va uni Scale (Masshtab) yordamida kichiklashtiring.
· Rotate (Burish) yordamida ob'ektni 45 darajaga buring.
· Flip Horizontal (Gorizontal akslantirish) amalini bajarib, rasmning ko'zgudagi aksini hosil qiling.
3. Murakkab shakl almashtirish amallari
Quyidagi transformatsiya turlarining vazifasini jadval ko'rinishida to'ldiring:
	Transformatsiya turi
	Vazifasi (Nima ish bajaradi?)

	Skew (Qreytish)
	Obyektni ma'lum bir burchak ostida qiya qilish

	Distort (Buzish)
	?

	Perspective (Perspektiva)
	?

	Warp (Eshish/Bukish)
	?


4. Labaratoriya ishi: "Kitob muqovasi simulatsiyasi"
1. Bitta tekis turgan kitob muqovasi rasmini va bitta qiya turgan (perspektivada) kitob rasmini tayyorlang.
2. Muqova rasmini kitob ustiga joylashtiring.
3. Distort yoki Perspective amallari yordamida muqovani kitobning qiyaligiga moslab joylashtiring (mock-up tayyorlash usuli).
5. Mantiqiy savol
Tasvirni kadrrashda (Crop) xususiyatlar panelidagi "Delete Cropped Pixels" katakchasi belgilanmagan bo'lsa, kesib tashlangan qismlar bilan nima sodir bo'ladi? Buning afzalligi nimada?
Topshiriqni topshirish shakli:
· Nazariy savollarga yozma javoblar (daftarda).
· Bajarilgan amaliy ishning ikki xil holati (kadrrashdan oldin va keyin) screenshotlari.
· Kitob muqovasi simulatsiyasining .psd fayli.

















7-Mavzu: Photoshopda qatlamlar (Layers) bilan ishlash
1. Nazariy qism: Qatlamlar ierarxiyasi
Quyidagi savollarga javob bering va qatlamlar panelidagi asosiy elementlarni tushuntiring:
· Qatlam (Layer) tushunchasi nima va u tasvirni tahrirlashda qanday qulaylik yaratadi?
· Qatlamlar panelidagi "ko'z" (Visibility) belgisining vazifasi nima?
· Qatlamlarning ketma-ketligi (tartibi) tasvirning umumiy ko'rinishiga qanday ta'sir qiladi?
2. Amaliy topshiriq: "Ko'pqatlamli kompozitsiya"
Adobe Photoshop dasturida quyidagi bosqichlarni bajarib, amaliy ishni amalga oshiring:
1. Hujjat yaratish: 1000x1000 px o'lchamda yangi fayl oching.
2. Fon bilan ishlash: Birinchi qatlamni (Background) biron bir rang bilan to'ldiring.
3. Yangi qatlamlar qo'shish:
· Yangi bo'sh qatlam yarating va unga biron bir shakl chizing.
· Yana bir qatlam ochib, unga matn (masalan, ismingizni) yozing.
4. Guruhlash va nomlash: Qatlamlarni mantiqiy nomlang (masalan: "Matn qatlami", "Shakl qatlami") va ularni bitta guruhga (Folder) birlashtiring.
5. Shaffoflik (Opacity): Yuqorigi qatlamning shaffofligini 50% gacha kamaytirib, natijani kuzating.
3. Texnik tahlil: Qatlamlarni aralashtirish (Blending Modes)
Quyidagi jadvalni to'ldiring (qatlamlar panelidagi "Normal" menyusi orqali sinab ko'ring):
	Rejim (Blending Mode)
	Tasvirga ta'siri (Kuzatuvlaringiz)

	Multiply
	Tasvirni to'qroq qiladi, oq ranglarni yashiradi

	Screen
	?

	Overlay
	?

	Difference
	?


4. Mantiqiy topshiriq: "Layer Mask" (Qatlam niqobi)
Bitta qatlamga rasm joylashtiring va unga Layer Mask qo'shing.
· Vazifa: Qora rangli yumshoq mo'yqalam (Brush) yordamida rasmning chetlarini "o'chirib" (yashirib), fon bilan silliq birlashishini ta'minlang.
· Savol: Layer Mask ishlatilganda rasm piksel darajasida o'chib ketadimi yoki shunchaki yashiriladimi? Buning "Eraser Tool"dan farqi nimada?
5. Ijodiy vazifa: "Raqamli kollaj"
Kamida 5 ta turli xil qatlamdan (rasm, matn, shakl, effektlar) foydalangan holda ixtiyoriy mavzuda kollaj tayyorlang. Ishingizda quyidagi amallar albatta bo'lishi kerak:
· Qatlamlar tartibini o'zgartirish.
· Qatlamni dublikat qilish (Ctrl + J).
· Qatlamlarni birlashtirish (Merge Layers).
Topshiriqni topshirish shakli:
· Savollarga yozma javoblar (daftarda).
· Bajarilgan ishning qatlamlari saqlangan holatdagi .psd fayli.
· Yakuniy natijaning .jpg yoki .png formati.
Rasmda keltirilgan "PhotoShopda ranglar bilan ishlash" mavzusi bo‘yicha o‘quvchilarning nazariy bilim va amaliy ko‘nikmalarini mustahkamlashga qaratilgan mustaqil ish topshiriqlarini tayyorladim.


















8-Mavzu: Photoshopda rang modellari va ranglar bilan ishlash.
1. Nazariy qism: Rang modellari tahlili
Quyidagi savollarga javob bering va rang modellarining asosiy farqlarini tushuntiring:
· RGB va CMYK rang modellarining farqi nimada? Nima uchun monitor uchun RGB, bosma (pechat) uchun CMYK ishlatiladi?
· Grayscale (kulrang tuslar) rejimi tasvirdagi rangli ma'lumotlarni qanday o'zgartiradi?
· Rang chuqurligi (8-bit, 16-bit) deganda nimani tushunasiz?
2. Amaliy topshiriq: "Ranglarni boshqarish asboblari"
Adobe Photoshop dasturida biron bir rangli fotosuratni oching va quyidagi amallarni bajaring:
1. Rang tanlash (Eyedropper Tool): Rasmdagi uchta turli nuqtadan rang namunalarini oling va ularning HEX kodlarini (#000000 ko'rinishida) yozib oling.
2. Rang balansini to'g'rilash (Color Balance): Image -> Adjustments -> Color Balance menyusi orqali rasmning rang haroratini o'zgartiring (masalan, rasmni "issiqroq" yoki "sovuqroq" tusga keltiring).
3. To'yinganlikni o'zgartirish (Hue/Saturation): Ctrl + U tugmalari yordamida rasmdagi bitta aniq rangni (masalan, faqat qizil rangni) butunlay boshqa rangga almashtiring.
3. Texnik tahlil: "Gradient va To'ldirish"
Quyidagi vazifalarni bajaring va natijani izohlang:
· Paint Bucket Tool (G): Yopiq konturli shaklni bitta rang bilan to'ldiring.
· Gradient Tool: Kamida uchta rangdan iborat chiziqli (Linear) va radial gradient hosil qiling.
· Savol: Gradientning shaffofligini (Opacity) qanday boshqarish mumkin?
4. Mantiqiy topshiriq: "Rangli filtrlash"
Rasmga Black & White filtrini qo'llang.
· Vazifa: Filtr sozlamalaridagi rangli slayderlar (Red, Yellow, Green...) yordamida rasmning qaysi qismlarini to'qroq yoki ochroq qilish mumkinligini aniqlang.
· Xulosa: Nima uchun rangli slayderlarni surish orqali oq-qora rasmning ko'rinishi o'zgaradi?
5. Ijodiy vazifa: "Ranglar uyg'unligi (Palette)"
Adobe Color yoki shunga o'xshash manbalardan foydalanib, 5 ta rangdan iborat uyg'un palitra (masalan, Complementary yoki Analogous) tanlang. Ushbu ranglardan foydalanib, Photoshopda oddiy abstrakt kompozitsiya (shakllar to'plami) yarating.
Topshiriqni topshirish shakli:
· Nazariy savollarga yozma javoblar (daftarda yoki elektron hujjatda).
· Amaliy ish natijalari (asl rasm va ranglari o'zgartirilgan variantlari) screenshotlari.
· Yaratilgan ranglar palitrasining HEX kodlari ro'yxati.
9-Mavzu: Photoshopda Mo‘yqalam (Brush) va Qalam (Pencil) asboblari.
1. Nazariy qism: Quyidagi savollarga javob bering va asboblarning o‘ziga xos jihatlarini tushuntiring:
· Mo‘yqalam (Brush Tool - B) va Qalam (Pencil Tool) asboblarining asosiy farqi nimada? Qirralarning yumshoqligi (Hardness) qaysi birida muhimroq?
· Mo‘yqalam sozlamalaridagi Opacity (shaffoflik) va Flow (oqim) parametrlarining bir-biridan farqini tushuntiring.
· Yangi mo‘yqalam turini (Brush Preset) qanday yaratish yoki yuklab olish mumkin?
2. Amaliy topshiriq: "Raqamli chizmachilik"
Adobe Photoshop dasturida yangi bo‘sh hujjat oching (o'lchami ixtiyoriy) va quyidagi bosqichlarni bajaring:
1. Chiziqlar bilan mashq:
· Qalam (Pencil) yordamida aniq, qattiq qirrali geometrik shakllar chizing.
· Mo‘yqalam (Brush) yordamida turli yumshoqlik darajasidagi (Hardness: 0%, 50%, 100%) chiziqlar chizib, farqini kuzating.
2. Ranglar uyg‘unligi: Mo‘yqalamdan foydalanib, bir rangdan ikkinchi rangga silliq o‘tish (gradient effekti) hosil qiling (buning uchun shaffoflikni kamaytirib, ranglarni ustma-ust surting).
3. Maxsus mo‘yqalamlar: Standart bo‘lmagan mo‘yqalam turini tanlang (masalan, barg, o't yoki bulut shaklidagi) va u orqali kichik bir kompozitsiya (tabiat manzarasi) yarating.
3. Texnik tahlil: "Sozlamalar paneli"
Mo‘yqalam sozlamalari oynasidagi (F5 tugmasi) quyidagi funksiyalarning vazifasini jadval ko'rinishida to'ldiring:
	Funksiya nomi
	Vazifasi (Nima uchun ishlatiladi?)

	Shape Dynamics
	Chiziq qalinligi va o'lchamining tasodifiy o'zgarishi

	Scattering (Sochilish)
	?

	Color Dynamics
	?

	Smoothing (Silliqlash)
	?



4. Mantiqiy topshiriq: "To'g'ri chiziq chizish"
Photoshopda mo‘yqalam bilan ishlaganda mutlaqo to‘g‘ri vertikal yoki gorizontal chiziq chizish uchun qaysi klaviatura tugmasidan foydalaniladi? Bir nuqtadan ikkinchi nuqtaga to‘g‘ri chiziq tortish usulini yozib bering.
5. Ijodiy vazifa: "Grafik imzo yaratish"
O'z ismingiz yoki biron bir ramzni Qalam asbobi yordamida piksel-art uslubida chizing. So‘ngra xuddi shu shaklni Mo‘yqalam yordamida "akvarel" uslubida (yumshoq va shaffof ranglar bilan) qayta ishlang.
Topshiriqni topshirish shakli:
· Nazariy savollarga daftarda yozma javoblar.
· Chizilgan namunalar saqlangan .psd fayli.
· Mo‘yqalam sozlamalari yordamida yaratilgan 3 xil turli teksturadagi chiziqlar screenshotlari.


















10-Mavzu: Web-texnologiyalar asoslari.
1. Nazariy qism: Quyidagi tushunchalarning o‘zaro farqini tushuntirib bering:
· Web-sahifa va Web-sayt o‘rtasidagi farq nimada? (Misol keltiring).
· Web-brauzer nima va u web-sahifalarni qanday o‘qiydi?
· URL manzil tarkibini tahlil qiling (masalan: [https://www.google.com](https://www.google.com)).
2. Amaliy topshiriq: "Web-dizayn elementlari"
O‘zingiz yoqtirgan biror web-saytni (masalan, yangiliklar sayti yoki ta’lim portali) tanlang va undagi web-dizayn elementlarini tahlil qiling:
1. Navigatsiya: Sayt menyusi qanchalik qulay joylashgan?
2. Ranglar gammasi: Saytda qaysi asosiy ranglardan foydalanilgan va ular foydalanuvchiga qanday ta’sir qiladi?
3. Tipografika: Matnlar shrifti va o‘lchami o‘qish uchun qulaymi?
4. Adaptivlik: Sayt mobil qurilmalarda qanday ko‘rinishini tekshiring.
3. Qiyosiy jadval
Web-dizaynning ikki asosiy yo‘nalishi bo‘yicha jadvalni to‘ldiring:
	Xususiyati
	UI (User Interface) dizayn
	UX (User Experience) dizayn

	Maqsadi
	Foydalanuvchiga vizual go‘zallik berish
	Foydalanuvchiga qulaylik yaratish

	Asosiy e’tibor
	Ranglar, tugmalar shakli, shriftlar
	?

	Savol
	Sayt chiroylimi?
	?


Экспортировать в Таблицы
4. Mantiqiy topshiriq: "Sizning birinchi loyihangiz"
Tasavvur qiling, sizga "Mening maktabim" mavzusida web-sayt yaratish topshirildi.
· Saytingizda kamida 5 ta asosiy bo‘lim (sahifa) nomini yozing.
· Saytning bosh sahifasi (Home page) qanday ko‘rinishini oddiy chizma (maket) ko‘rinishida qog‘ozda tasvirlang.
· Web-dizayn qoidalariga ko‘ra, bosh sahifada eng muhim qaysi ma’lumot bo‘lishi kerak deb hisoblaysiz?
5. Ijodiy izlanish
Hozirgi kunda web-dizayndagi eng so‘nggi trendlardan biri haqida qisqacha ma’lumot to‘plang (masalan: Dark Mode, Minimalism, 3D elements). Nima uchun ushbu trend ommalashganini izohlang.
Topshiriqni topshirish shakli:
· Nazariy savollarga daftarda yozma javoblar.
· Web-sayt maketining chizmasi.
· Tahlil qilingan sayt bo‘yicha qisqacha xulosa (prezentatsiya yoki matn ko‘rinishida).
Rasmda keltirilgan "Web-dizayn va uning dasturiy ta'minoti" mavzusi bo‘yicha o‘quvchilarning texnik bilimlarini boyitish va zamonaviy vositalar bilan tanishtirishga qaratilgan mustaqil ish topshiriqlarini tayyorladim.






















11-Mavzu: Web-dizayn va uning dasturiy ta'minoti.
1. Nazariy qism: Dasturiy ta'minot turlari
Web-dizayn jarayonida ishlatiladigan dasturlarni vazifasiga ko‘ra tasniflang va quyidagi savollarga javob bering:
· Grafik muharrirlar: Web-elementlarni yaratishda nima uchun Adobe Photoshop (rastrli) va Adobe Illustrator (vektorli) dasturlari birdek muhim?
· Prototiplash asboblari: Figma yoki Adobe XD kabi dasturlarning an'anaviy grafik muharrirlardan asosiy farqi nimada?
· Kod tahrirlagichlar: Dizaynni kodga o‘tkazishda (layout) qaysi dasturlardan (masalan, VS Code, Sublime Text) foydalaniladi?
2. Amaliy topshiriq: "Dizayn vositalari tahlili"
Quyidagi dasturlardan birini tanlang va uning web-dizayner uchun taqdim etadigan 3 ta eng muhim funksiyasini yozib chiqing:
1. Figma (Bulutli texnologiya va jamoaviy ishlash).
2. Canva (Tayyor shablonlar va tezkor dizayn).
3. Adobe Photoshop (Murakkab tasvirlarni qayta ishlash).
3. Qiyosiy jadval: Desktop vs Online
Web-dizayn dasturlarining ikki xil ko‘rinishini o‘zaro solishtiring:
	Xususiyati
	Desktop dasturlar (Photoshop, AI)
	Online servislar (Figma, Canva)

	Internetga bog‘liqlik
	Internetiz ishlash imkoniyati bor
	Doimiy internet talab qilinadi

	Resurslar sarfi
	Kompyuter quvvatiga talabchan
	?

	Jamoaviy ishlash
	?
	Real vaqt rejimida birgalikda ishlash


4. Mantiqiy topshiriq: "Loyihani rejalashtirish"
Sizga bitta kichik biznes uchun "Landing Page" (bir sahifali sayt) dizaynini yaratish topshirildi. Ishni qaysi tartibda amalga oshirasiz? Dasturlarni qo‘llash ketma-ketligini belgilang:
1. G'oyani qog‘ozga chizish (Sketching).
2. Strukturaviy karkas yaratish (Wireframe) — Qaysi dasturda?
3. Rangli va grafikli vizual dizayn yaratish — Qaysi dasturda?
4. Interaktiv prototip hosil qilish — Qaysi dasturda?
5. Ijodiy vazifa: "Asboblar qutisi"
O‘zingiz uchun eng qulay deb hisoblagan web-dizayn dasturlaridan iborat "ideal ish qurollari" ro‘yxatini tuzing. Nima uchun aynan shu dasturlarni tanlaganingizni 3 ta sabab bilan asoslang.
Topshiriqni topshirish shakli:
· Savollarga yozma javoblar (daftarda yoki Word hujjatida).
· Tanlangan dastur haqida qisqacha taqdimot yoki infografika.
· Dasturiy ta'minotlarni o‘rnatish yoki ro‘yxatdan o‘tish bo‘yicha kichik qo‘llanma (instruktsiya).



















12-Mavzu: Web-sahifalarda multimedia elementlari bilan ishlash.
1. Nazariy qism: Tasvir formatlari va HTML teglari
Quyidagi savollarga javob bering va web-grafika asoslarini tushuntiring:
· Web-sahifalarda ishlatiladigan asosiy rasm formatlari (JPEG, PNG, GIF, SVG) bir-biridan qanday farq qiladi? Qaysi holatda qaysi formatdan foydalanish maqsadga muvofiq?
· HTML hujjatiga rasm joylashtirish uchun ishlatiladigan <img> tegining asosiy atributlari (src, alt, width, height) nima vazifani bajaradi?
· Alt (alternative text) atributining qidiruv tizimlari (SEO) va imkoniyati cheklangan foydalanuvchilar uchun ahamiyati nimada?
2. Amaliy topshiriq: "Rasm joylashtirish va o‘lcham berish"
Oddiy HTML sahifa yarating va quyidagi bosqichlarni bajaring:
1. Tasvirni ulanishi: Kompyuteringizdagi biror rasmni img tegi yordamida sahifaga chiqaring.
2. O‘lchamlarni boshqarish: Rasmning asl o‘lchamini o‘zgartirmasdan, HTML atributlari yordamida uning kengligini (width) 300 pikselga sozlang.
3. Tavsif berish: Agar rasm biron sababga ko‘ra yuklanmay qolsa, uning o‘rnida "Mening rasmi" degan yozuv chiqishi uchun kerakli atributni qo‘shing.
3. Texnik tahlil: CSS orqali bezash
Joylashtirilgan rasmga CSS yordamida quyidagi uslublarni qo‘llang va natijani izohlang:
· border: Rasmga 5 pikselli rangli chegara bering.
· border-radius: Rasmning burchaklarini yumaloqlang (masalan, 15px yoki 50%).
· box-shadow: Rasmga soya effekti qo‘shing.
· opacity: Rasmning shaffofligini 0.7 ga tushirib ko‘ring.
4. Mantiqiy topshiriq: "Tasvirni matn bilan o‘rab olish"
Web-dizaynda rasm va matnning joylashuvi muhim ahamiyatga ega.
· Vazifa: CSS’dagi float (left yoki right) xususiyatidan foydalanib, rasmni matnning chap yoki o‘ng tomoniga joylashtiring.
· Savol: Rasm va matn bir-biriga yopishib qolmasligi uchun qaysi xususiyat (margin yoki padding) orqali rasm atrofida bo‘sh joy qoldiriladi?
5. Ijodiy vazifa: "Grafikli galereya"
Kamida 4 ta rasmdan iborat kichik "Foto-galereya" yarating.
· Barcha rasmlar bir xil balandlik va kenglikda bo‘lishini ta'minlang.
· Har bir rasm ustiga sichqoncha olib borilganda (:hover), rasmning o‘lchami biroz kattalashadigan yoki rangi o‘zgaradigan effekt qo‘shing (transform: scale yoki filter yordamida).
Topshiriqni topshirish shakli:
· Nazariy savollarga daftarda yoki elektron formatda yozma javoblar.
· Yaratilgan .html va .css fayllari (yoki kod matni).
· Sahifaning brauzerdagi ko‘rinishi (screenshot).























13-Mavzu: Web-formalarni CSS yordamida bezash
1. Nazariy qism: Formaning strukturasi
Quyidagi savollarga javob bering va formalarni bezashda ishlatiladigan asosiy tushunchalarni izohlang:
· HTMLda <form> elementi ichida ishlatiladigan <label> tegining vazifasi va uni input bilan bog‘lashning ahamiyati nimada?
· Forma elementlari uchun ishlatiladigan placeholder va value atributlarining farqi nimada?
· Foydalanuvchi ma'lumot kirityotganda input maydonining rangi o'zgarishi uchun CSS’ning qaysi psevdo-klasidan (:focus) foydalaniladi?
2. Amaliy topshiriq: "Kirish formasi (Login Form)"
Quyidagi talablar asosida oddiy kirish formasini yarating va bezang:
1. Struktura: Sahifaga "Foydalanuvchi nomi" va "Parol" uchun ikkita input maydoni hamda "Kirish" tugmasini (button) joylashtiring.
2. Kenglik va masofa: Input maydonlarining kengligini 100% qiling va ular orasida bo‘sh joy qoldirish uchun margin xususiyatidan foydalaning.
3. Chegaralar (Borders): Input maydonlarining standart chegaralarini olib tashlang va faqat pastki qismiga chiziq bering (border-bottom).
3. Texnik tahlil: Tugmalar va Interaktivlik
Formadagi tugmani bezash uchun quyidagi CSS uslublarini qo‘llang:
· Background-color: Tugmaga yorqin rang bering.
· Border-radius: Tugmaning burchaklarini yumaloqlang.
· Hover effekti: Sichqoncha tugma ustiga kelganda rangini o‘zgartiruvchi va kursorni ko‘rsatkichga (cursor: pointer) aylantiruvchi kod yozing.
· Transition: Rang o‘zgarishi silliq chiqishi uchun transition: 0.3s xususiyatini qo‘shing.
4. Mantiqiy topshiriq: "Validatsiya va Xatolar"
Forma elementlarining holatiga qarab vizual javob qaytarishni o'rganing:
· Vazifa: CSS’dagi :invalid va :valid psevdo-klaslaridan foydalanib, agar ma'lumot noto'g'ri kiritilsa (masalan, type="email" maydoniga), maydon chegarasini qizil rangga, to'g'ri bo'lsa yashil rangga o'zgaradigan qiling.
· Savol: Nima uchun formani bezashda foydalanuvchiga xatolarni darhol ko'rsatish (User Experience - UX) muhim hisoblanadi?
5. Ijodiy vazifa: "Ro‘yxatdan o‘tish formasi (Registration Page)"
Kengaytirilgan ro‘yxatdan o‘tish formasini dizayn qiling. Unda quyidagilar bo‘lsin:
· Ma'lumot kiritish maydonlari (Ism, Email, Tug‘ilgan sana).
· Tanlov tugmalari (radio yoki checkbox) va ularni CSS yordamida chiroyli ko‘rinishga keltirish.
· Butun formani sahifa markaziga joylashtirish uchun Flexbox yoki Grid texnologiyasidan foydalaning.
Topshiriqni topshirish shakli:
· Nazariy savollarga daftarda yoki elektron hujjatda yozma javoblar.
· Yaratilgan .html va .css fayllari (formaning to‘liq kodi).
· Tayyor formaning brauzerdagi ko‘rinishi (screenshot).






















14-Mavzu: Web-sahifalarda giperhavolalar va navigatsiya tizimi.
1. Nazariy qism: Havolalar turlari va HTML teglari
Quyidagi tushunchalarni tahlil qiling va savollarga javob bering:
· Absolyut va Nisbiy (Relative) havolalarning farqi nimada? Qaysi holatda qaysi biridan foydalanish qulayroq?
· HTMLda havola yaratish uchun ishlatiladigan <a> tegining asosiy atributi bo'lgan href nima vazifani bajaradi?
· Havola bosilganda sahifani yangi oynada ochish uchun qaysi atribut va qiymatdan (target="_blank") foydalaniladi?
2. Amaliy topshiriq: "Navigatsiya menyusini yaratish"
Oddiy web-sayt strukturasini yarating va quyidagi amallarni bajaring:
1. Ichki aloqalar: Kompyuteringizda uchta HTML fayl yarating (index.html, about.html, contact.html). Ularni o'zaro nisbiy havolalar orqali bog'lab, bosh menyu hosil qiling.
2. Tashqi aloqalar: Saytingizga Google, YouTube yoki ta'lim portallariga yo'naltiruvchi absolyut havolalar joylashtiring.
3. Hujjat ichidagi aloqalar (Anchor): Uzun matnli sahifa yarating va sahifaning yuqori qismidan pastki qismiga tezkor o'tish imkonini beruvchi "Loxar" (Anchor - #id) havolalarini o'rnating.
3. Texnik tahlil: CSS orqali havolalarni bezash
Havolalarning holatiga qarab ularning ko'rinishini o'zgartirish uchun CSS psevdo-klaslaridan foydalaning:
· :link — hali bosilmagan havola rangi.
· :visited — foydalanuvchi kirib ko'rgan havola rangi.
· :hover — sichqoncha havola ustiga kelgandagi effekt (masalan, rang o'zgarishi yoki tagiga chizish).
· :active — havola bosilayotgan paytdagi ko'rinishi.
4. Mantiqiy topshiriq: "Multimedia va Fayllarga havolalar"
Faqat sahifadan sahifaga o'tish emas, balki boshqa imkoniyatlarni ham sinab ko'ring:
· Elektron pochta: Foydalanuvchi bosganda avtomatik pochta dasturi ochiladigan havola yarating (mailto:).
· Fayl yuklash: Biror rasm yoki PDF hujjatni yuklab olish imkonini beruvchi havola hosil qiling (download atributi yordamida).
· Telefon raqami: Mobil qurilmalarda bosganda qo'ng'iroq qilish oynasini ochadigan havola yarating (tel:).
5. Ijodiy vazifa: "Grafik havolalar"
Matnli havolalardan tashqari, grafik elementlardan foydalaning:
· Biror rasmni havola vazifasini bajaradigan qiling (rasmni bosganda boshqa sahifaga o'tsin).
· Ijtimoiy tarmoq piktogrammalarini (ikonkalarini) joylashtiring va ularni tegishli manzillarga bog'lang.
Topshiriqni topshirish shakli:
· Nazariy savollarga yozma javoblar (daftarda yoki elektron hujjatda).
· Yaratilgan bir nechta o'zaro bog'langan .html fayllari to'plami.
· Havolalar to'g'ri ishlayotganini ko'rsatuvchi videoxabar yoki screenshotlar seriyasi.





















15-Mavzu: Axborot xavfsizligi asoslari va uning samaradorligi.
1. Nazariy qism: Konseptual asoslar
Quyidagi savollarga javob bering va axborot xavfsizligining "uch ustuni"ni izohlang:
· Axborot xavfsizligining asosiy tamoyillari bo‘lgan Konfidensiallik, Butunlik va Mavjudlik (Accessibility) tushunchalariga ta’rif bering.
· Axborot xavfsizligiga tahdid deganda nima tushuniladi? Tahdidlarni ob’ektiv va sub’ektiv turlarga ajratib ko‘rsating.
· Nima uchun hozirgi raqamli iqtisodiyot davrida axborot xavfsizligi samaradorligini o‘lchash muhim ahamiyatga ega?
2. Amaliy tahlil: "Samaradorlik ko‘rsatkichlari"
Axborot xavfsizligi tizimining samaradorligini baholash uchun ishlatiladigan quyidagi ko‘rsatkichlarni tahlil qiling:
1. Vaqt ko‘rsatkichi: Tahdidni aniqlash va unga javob qaytarish (Response time) tezligi tizim samaradorligiga qanday ta’sir qiladi?
2. Moliyaviy ko‘rsatkich: Axborotni himoya qilish uchun sarflangan xarajatlar va himoya qilinayotgan axborotning qiymati o‘rtasidagi mutanosiblikni qanday baholash mumkin?
3. Ishonchlilik: Tizimning uzoq vaqt davomida xatosiz ishlash ehtimolini qaysi mezonlar belgilaydi?
3. Muammoli vaziyat (Keys): "Xavfsizlikni baholash"
Tasavvur qiling, siz biror ta’lim muassasasining (masalan, Guliston Davlat Universiteti Akademik Litseyining) axborot xavfsizligi bo‘yicha mutaxassisiz.
· Muassasaning EMIS yoki LMS platformalaridagi ma’lumotlar xavfsizligini ta’minlash uchun qanday texnik va tashkiliy choralar ko‘rgan bo‘lar edingiz?
· Ushbu choralarning samaradorligini qaysi ko‘rsatkichlar orqali tekshirasiz? (Misol: Bir yil ichida kiberhujumlar sonining kamayishi).
4. Mantiqiy topshiriq: "Samaradorlikni oshirish strategiyasi"
Axborot xavfsizligi samaradorligini oshirish bo‘yicha quyidagi jadvalni to‘ldiring:
	Chora-tadbirlar
	Samaradorlikka ta’siri
	Kutilayotgan natija

	Antivirus dasturlarini yangilash
	Zararli dasturlardan himoyalanish
	Tizimning barqaror ishlashi

	Xodimlarni o‘qitish (Kibersavodxonlik)
	?
	?

	Zaxira nusxa ko‘chirish (Backup)
	?
	?

	Ikki bosqichli autentifikatsiya
	?
	?



5. Ijodiy vazifa: "Axborot xavfsizligi pasporti"
Siz foydalanadigan shaxsiy kompyuter yoki smartfonning axborot xavfsizligi holatini baholang.
· Qurilmangizdagi eng zaif nuqtalarni aniqlang.
· Xavfsizlik samaradorligini 10 ballik shkalada baholang va uni 2 pog‘onaga ko‘tarish uchun amalga oshirilishi kerak bo‘lgan 3 ta aniq qadamni yozing.
Topshiriqni topshirish shakli:
· Nazariy va amaliy savollarga yozma javoblar (daftarda yoki elektron hujjatda).
· Tahliliy jadval va keys yechimi.
· Siz taklif etgan xavfsizlik choralarini aks ettiruvchi qisqacha infografika yoki taqdimot.
Rasmda keltirilgan "Mintaqaviy kompyuter tarmog‘i va uni himoyalash" mavzusi bo‘yicha o‘quvchilarning tarmoq texnologiyalari va kiberxavfsizlik sohasidagi bilimlarini amaliy mustahkamlashga qaratilgan mustaqil ish topshiriqlarini tayyorladim.














16-Mavzu: Mintaqaviy tarmoqlar (MAN) va xavfsizlik asoslari.
1. Nazariy qism: Tarmoq miqyosi va tahlili
Quyidagi savollarga javob bering va mintaqaviy tarmoqlarning o‘ziga xos xususiyatlarini izohlang:
· MAN (Metropolitan Area Network) nima va u LAN (Mahalliy) hamda WAN (Global) tarmoqlardan qanday farq qiladi?
· Mintaqaviy tarmoqlar odatda qaysi hududlarni qamrab oladi? (Misol: Shahar miqyosidagi universitetlar yoki banklar tarmog‘i).
· Mintaqaviy tarmoqlarda ma’lumot uzatish uchun asosan qaysi aloqa kanallaridan (Optik tolali, sun’iy yo‘ldosh va h.k.) foydalaniladi?
2. Amaliy tahlil: "Tarmoq xavfsizligi tahdidlari"
Katta hududni qamrab olgan tarmoqlarda xavfsizlikni ta’minlash qiyinroq kechadi. Quyidagi tahdidlar haqida qisqacha ma’lumot to‘plang va ularni mintaqaviy tarmoq kontekstida tushuntiring:
1. DoS va DDoS hujumlar: Mintaqaviy serverlarning ishdan chiqishi qanday oqibatlarga olib keladi?
2. Ma’lumotlarni tutib qolish (Sniffing): Ochiq kanallar orqali uzatilayotgan axborotni qanday himoya qilish mumkin?
3. Ruxsatsiz kirish: Tarmoq nuqtalariga begona shaxslarning ulanishini qanday cheklash mumkin?
3. Texnik loyihalash: "Himoya qatlamlari"
Mintaqaviy tarmoqni himoyalash uchun quyidagi texnologiyalarning vazifasini yozib chiqing:
· Firewall (Tarmoqlararo ekran): Tashqi va ichki tarmoq orasidagi "filtr" vazifasini qanday bajaradi?
· VPN (Virtual Private Network): Masofadan turib mintaqaviy tarmoqqa xavfsiz ulanishni qanday ta’minlaydi?
· IDS/IPS (Hujumlarni aniqlash va oldini olish tizimlari): Tarmoqdagi shubhali harakatlarni qanday nazorat qiladi?
4. Mantiqiy topshiriq: "Tarmoq xaritasini chizish"
Tasavvur qiling, siz bir shahardagi bir nechta filialga ega tashkilotning tarmoq muhandisidiz.
· Vazifa: Filiallar orasidagi mintaqaviy tarmoqning sodda sxemasini chizing.
· Sxemada xavfsizlik vositalari (server, router, firewall) qayerda joylashishi kerakligini ko‘rsating.
· Ma’lumotlar butunligini ta’minlash uchun qanday shifrlash usullarini qo‘llashni taklif qilasiz?
5. Ijodiy vazifa: "Xavfsizlik bayonnomasi"
Mintaqaviy tarmoqdan foydalanuvchi xodimlar yoki talabalar uchun 5 ta banddan iborat "Tarmoq xavfsizligi qoidalari" (Yo‘riqnoma) ishlab chiqing. Bunda parollar siyosati va shubhali havolalar bilan ishlashga alohida e’tibor bering.
Topshiriqni topshirish shakli:
· Savollarga yozma javoblar (daftarda yoki Word hujjatida).
· Mintaqaviy tarmoqning xavfsizlik sxemasi (grafik ko'rinishda).
· Tarmoqni himoyalash bo‘yicha tayyorlangan tavsiyalar ro‘yxati.





















17-Mustaqil ish: Global kompyuter tarmoqlari (WAN) va Internet.
1. Nazariy qism: Tushunchalar va arxitektura
Quyidagi savollarga javob bering va global tarmoqlarning ishlash tamoyillarini tushuntiring:
· WAN (Wide Area Network) nima va u qanday qilib qit’alararo ma’lumot almashinuvini ta’minlaydi?
· Global tarmoqlarning eng yirik namunasi bo‘lgan Internet tarmog‘ining asosiy protokoli — TCP/IP haqida ma’lumot bering.
· DNS (Domain Name System) nima va u raqamli IP manzillarni bizga tanish bo‘lgan matnli manzillarga (masalan, google.com) qanday aylantiradi?
2. Amaliy tahlil: "Tarmoq provayderlari va ulanish turlari"
Global tarmoqqa ulanishning turli usullarini o‘rganing va ularning afzalliklarini yozib chiqing:
1. Sputnik (sun’iy yo‘ldosh) aloqasi: Chekka hududlarda global tarmoqqa ulanishning o‘rni.
2. Optik tolali aloqa: Dunyo okeanlari tubidan o‘tgan global kabellar haqida qisqacha ma’lumot to‘plang.
3. Mobil tarmoqlar (4G/5G): Global tarmoqning mobil segmenti qanday rivojlanmoqda?
3. Texnik topshiriq: "Axborot oqimi yo‘nalishi"
Global tarmoqda ma’lumotlar qanday harakatlanishini tushunish uchun quyidagi tushunchalarni izohlang:
· Router (Yo‘naltirgich): Ma’lumot paketlari uchun eng maqbul yo‘lni qanday tanlaydi?
· Gateway (Shlyuz): Turli xil protokollarda ishlovchi tarmoqlarni o‘zaro qanday bog‘laydi?
· Server va Klient: Global tarmoqdagi asosiy sub’ektlarning o‘zaro aloqasi.
4. Mantiqiy topshiriq: "Global tarmoq xaritasi va xavfsizlik"
Internet nafaqat imkoniyat, balki mas’uliyat hamdir:
· Vazifa: Dunyo bo‘ylab ma’lumotlar markazlari (Data Centers) qanday joylashganini va ularning ahamiyatini tahlil qiling.
· Kiberxavfsizlik: Global tarmoqda shaxsiy ma’lumotlarni himoya qilish uchun nima uchun HTTPS protokoli va shifrlash usullaridan foydalaniladi?
· Global tarmoqning jamiyat hayotidagi (ta’lim, iqtisodiyot, muloqot) ijobiy va salbiy tomonlarini jadval ko‘rinishida keltiring.
5. Ijodiy vazifa: "Kelajak tarmog‘i"
Bundan 20 yil keyingi global kompyuter tarmog‘i qanday ko‘rinishda bo‘lishini tasavvur qiling.
· Axborot uzatish tezligi qanchaga yetishi mumkin?
· Sun’iy intellekt global tarmoq boshqaruvida qanday rol o‘ynaydi?
· O‘z qarashlaringizni kichik esse yoki "Kelajak tarmog‘i strukturasi" chizmasi ko‘rinishida taqdim eting.
Topshiriqni topshirish shakli:
· Nazariy savollarga yozma javoblar (daftarda yoki Word hujjatida).
· Global tarmoq ulanish sxemasi yoki infografikasi.
· Kelajak tarmog‘i haqidagi qisqacha esse.
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18-Mavzu: Elektron pochta xizmatining ishlash tamoyillari va tuzilmasi.
1. Nazariy qism: Elektron pochta arxitekturasi
Quyidagi savollarga javob bering va elektron pochtaning texnik asoslarini tushuntiring:
· Elektron pochta manzilining tuzilmasi qanday qismlardan iborat? (Masalan: foydalanuvchi@domen.uz). @ belgisi nima vazifani bajaradi?
· Elektron pochta xizmatining asosiy protokollari bo‘lgan SMTP, POP3 va IMAP o‘rtasidagi farqlarni tushuntiring. Qaysi biri xatni yuborish, qaysilari qabul qilish uchun xizmat qiladi?
· Mail Server (Pochta serveri) nima va u xatlarni manzilingizga yetib borguncha qanday saqlaydi?
2. Amaliy tahlil: "Xatning yo‘l xaritasi"
Xat yuborilgan vaqtdan to qabul qiluvchining ekranida ko‘ringuncha bosib o‘tadigan bosqichlarini tahlil qiling:
1. Yozish va yuborish: Foydalanuvchi (UA - User Agent) xatni yozadi va serverga yuboradi.
2. Serverlararo aloqa: Yuboruvchi serveri qabul qiluvchi serverini qanday qidirib topadi?
3. Qabul qilish: Xat qabul qiluvchining pochta qutisiga (Mailbox) qanday joylashadi?
3. Texnik topshiriq: "Xavfsizlik va Etika"
Elektron pochta orqali muloqotda xavfsizlikni ta’minlash choralarini o‘rganing:
· Spam va Fishin: Keraksiz va xavfli xatlardan himoyalanishning 3 ta asosiy usulini yozing.
· Shifrlash: Xat mazmuni begona shaxslar tomonidan o‘qilmasligi uchun qanday texnologiyalardan foydalaniladi?
· Fayl biriktirish: Biriktirilgan fayllarning hajmi bo‘yicha cheklovlar nima uchun mavjud?
4. Mantiqiy topshiriq: "Pochta xizmatlarini qiyoslash"
Bugungi kunda eng ommabop bo‘lgan pochta xizmatlarini (masalan, Gmail, Outlook, Mail.ru) quyidagi mezonlar bo‘yicha solishtiring:
· Bepul taqdim etiladigan xotira hajmi.
· Interfeys qulayligi va qo‘shimcha imkoniyatlar (kalendar, bulutli saqlash bilan integratsiya).
· Xavfsizlik darajasi (ikki bosqichli autentifikatsiya va h.k.).
5. Ijodiy vazifa: "Rasmiy xat loyihasi"
Tasavvur qiling, siz Guliston Davlat Universiteti Akademik Litseyi rahbariyatiga o‘quv jarayonini takomillashtirish bo‘yicha taklif yubormoqchisiz.
· Vazifa: Elektron pochta etiketiga amal qilgan holda xat loyihasini tayyorlang.
· Xatda Mavzu (Subject), Salomlashish, Asosiy qism va Imzo qismlari aniq ko‘rinsin.
· Xatga "Takliflar" nomli PDF fayl biriktirilganini tasvirlang.
Topshiriqni topshirish shakli:
· Nazariy savollarga yozma javoblar.
· Elektron pochta protokollarining ishlash sxemasi (diagramma ko‘rinishida).
· Tayyorlangan rasmiy xat namunasi (matn formatida).

